ScanWorks Scan Software
Installation and Operating Manual
Version 1.5
September 2010
ScanWorks to v2.4.7.6

PAS 180
Colortrac Ltd.

www.colortrac.com

Colortrac Ltd, 3-5 Brunel Court St. Ives Cambridgeshire
PE27 3LW UK
Tel: +44 (0) 1480 464618, Fax: +44 (0) 1480 464620

Overview
Copyright Colortrac Ltd
All rights reserved

Offices at:

Colortrac Limited

Colortrac Inc

Colortrac Ltd Beijing

Colortrac HQ and Factory
Colortrac Ltd, 3-5 Brunel
Court St. Ives
Cambridgeshire
PE27 3LW United Kingdom

Colortrac Inc.
4431-A Brookfield Corporate
Drive
Chantilly
Virginia
20151
USA

Room 4-B1B
Building No.7
Section 3, Century City
HaiDian district, Beijing 100089
P.R. China

Tel +1 703 717 5631
Fax +1 703 717 5361

T:+86(0)1051 988928
F:+86(0)1051 988927

T: +44 (0)1480 464618
F: +44 (0)1480 464620

Colortrac Imaging System
(Suzhou) Co. Ltd

Tel +86 1051 988928
Mob +86 13801 187193
Fax +86 1051 988927

Building No. 57, DongJing
Industrial Zone
No. 2 XieTang DongFu Road
Loufeng East District
SuZhou Industrial Park (SIP)
P.C. 215123
JiangSu Province
P.R. China

This documentation may not be reproduced or transmitted in any means, electronic or mechanical, for any purpose, except with the express prior
written permission of Colortrac Ltd.
Colortrac Ltd. makes no warranty claims with respect to this documentation and disclaims any implied warranties of merchantability or fitness for a
particular purpose. The information contained in this document is subject to change without notice. Colortrac Ltd. assumes no responsibility for
errors or omissions that may appear in this documentation.
September 2010

II

ScanWorks Installation and Operating Manual V1.5

Overview
1

OVERVIEW ....................................................................................................................................................... 5
1.1

2

HOW TO USE THIS MANUAL ............................................................................................................................. 6
SCANWORKS INSTALLATION....................................................................................................................... 7

2.1
2.2
3

SYSTEM REQUIREMENTS FOR SCANW ORKS AND SMARTLF.............................................................................. 7
SCANW ORKS INSTALLATION ........................................................................................................................... 8
GETTING STARTED WITH SCANWORKS ..................................................................................................... 9

3.1
3.1.1
3.1.2
3.1.3
3.1.4
3.1.5
3.1.6
3.1.7
3.2
3.2.1
3.2.2
3.2.3
3.3
3.4
3.5
4

SCAN CONFIGURATION CONTROLS ............................................................................................................... 10
Scan ....................................................................................................................................................... 10
Filename ................................................................................................................................................. 12
Paper Motion Controls ............................................................................................................................ 13
ScanWorks Units of operation (mm or inches) – Preferences Tab ........................................................ 14
Paper Size Controls ............................................................................................................................... 16
Resolution............................................................................................................................................... 17
DataType ................................................................................................................................................ 18
FILE FORMAT / PALETTES ............................................................................................................................. 19
File Format ............................................................................................................................................. 19
Palettes – Fixed (in-line processing) ...................................................................................................... 20
Palettes – Auto (in-line processing) ....................................................................................................... 21
MEDIA HANDLING ......................................................................................................................................... 22
DATA CONTROL (THE SCANNER INTERNAL SETTINGS) ..................................................................................... 24
THE THUMBNAIL W INDOW ............................................................................................................................ 25

THE VIEWING DESKTOP .............................................................................................................................. 26
4.1

THE „LOUPE‟ AND SCREEN DISPLAY MODES ................................................................................................... 27
ScanWorks Installation and Operating Manual V1.5

1

Overview
5

THE TABS INSIDE THE EDITING CONTROLS AREA .................................................................................28

6

EDITING CONTROL AREA (COLOR AND IMAGE EDITING CONTROLS) ................................................29
6.1
FILTERS AND CONTROLS FOR RGB AND GRAYSCALE .....................................................................................29
FILTERS AND CONTROLS FOR RGB AND GRAYSCALE CONTD. ....................................................................................30
6.2
FILTERS AND CONTROLS FOR 256 COLOR (OR INDEXED COLOR) .....................................................................31
6.3
FILTERS AND CONTROLS FOR 1-BIT COLOR OR BLACK AND W HITE (BINARY COLOR) .........................................31

7

MAKING YOUR FIRST SMARTLF SCAN .....................................................................................................32
7.1
7.2
7.3

CHECKING THE SETTINGS .............................................................................................................................32
SAVING YOUR FIRST PRESET ........................................................................................................................32
STARTING THE SCAN ....................................................................................................................................33

8

THE SCANWORKS PULL DOWN MENUS ...................................................................................................36

9

SCANNER MAINTENANCE ...........................................................................................................................38
9.1
LIGHT WARM-UP PERIOD ...............................................................................................................................38
9.2
CALIBRATION ...............................................................................................................................................38
9.3
CLEANING THE SCANNER GLASS ...................................................................................................................38
9.3.1
Stitch Procedure .....................................................................................................................................38

10

MORE ADVANCED TECHNIQUES – IMAGE CONTROLS ..........................................................................39

10.1
10.2
10.3
10.3.1
10.4
10.4.1
2

SHARPEN / BLUR..........................................................................................................................................40
NOISE REDUCTION .......................................................................................................................................41
RGB CURVES EDITING.................................................................................................................................42
Using the ScanWorks RGB curve editor ................................................................................................43
BRIGHTNESS - CONTRAST ............................................................................................................................45
Using the ScanWorks Brightness / Contrast curve editor ......................................................................46
ScanWorks Installation and Operating Manual V1.5

Overview
10.5
10.5.1
10.6
10.7
10.8
10.9
10.10
10.11
10.12
11

BLACK / W HITE POINT .................................................................................................................................. 47
Using the Black – White Slider ............................................................................................................... 48
DESKEW ..................................................................................................................................................... 49
ROTATE ...................................................................................................................................................... 50
CROP .......................................................................................................................................................... 51
MIRROR ...................................................................................................................................................... 52
CONVERT TO . . . ....................................................................................................................................... 53
RESAMPLE ............................................................................................................................................... 54
INVERT ..................................................................................................................................................... 55

MONOCHROME SCANNING – INTERACTIVE DYNAMIC THRESHOLDING ............................................. 56

11.1
11.2
11.3
11.4

ADAPTIVE THRESHOLDING IN BLACK & W HITE. .............................................................................................. 57
BASIC THRESHOLDING IN BLACK & W HITE..................................................................................................... 58
DITHERED THRESHOLDING IN BLACK & W HITE .............................................................................................. 59
DESPECKLING WITH BLACK AND W HITE SCANNING......................................................................................... 60

12

4 -TIER AUTO INCREMENT FILE NAMING ................................................................................................. 61

13

PRINTING FROM SCANWORKS .................................................................................................................. 62

14

SCANWORKS BATCH PROCESSOR .......................................................................................................... 63

14.1
14.2
14.3
14.3.1
14.4
14.5
14.6

RUNNING UNATTENDED (AUTO-SAVE) ........................................................................................................... 63
RUNNING WITH OPERATOR PRESENT (QUALITY CONTROL MODE) ................................................................... 63
USING PRESETS WITH SCANW ORKS BATCH COMMAND.................................................................................. 64
The Batch Command interfaces. ............................................................................................................ 65
USING THE SCANW ORKS BATCH SCHEDULER ............................................................................................... 66
CREATING A BATCH CONFIGURATION IN SCANW ORKS ................................................................................... 66
EDITING A BATCH CONFIGURATION IN SCANW ORKS....................................................................................... 66
ScanWorks Installation and Operating Manual V1.5

3

Overview
15

COLOR CLASSIFICATION ............................................................................................................................67

15.1
15.2
16

APPENDIX ......................................................................................................................................................70

16.1
16.2
16.3
16.4
16.5
16.6
16.7

4

REDUCING A FULL COLOR SCAN TO 64 OR FEWER COLORS ............................................................................67
COMBINING AND CHANGING COLORS IN A SCAN ..............................................................................................68
HARDWARE INSTALLATION – (SKIP THIS SECTION IF YOUR SCANNER IS ALREADY INSTALLED) ............................70
USB2 PRECAUTIONS ....................................................................................................................................70
COMPUTER HARDWARE RECOMMENDATIONS .................................................................................................70
CABLE LENGTH ............................................................................................................................................70
COLOR DEPTH FILE SIZE CALCULATIONS (WITHOUT COMPRESSION) ................................................................70
SCANW ORKS LICENSING LIMITATIONS ...........................................................................................................71
TURBO MODE BUTTON .................................................................................................................................71

ScanWorks Installation and Operating Manual V1.5

Overview

1

Overview

ScanWorks has been designed to convert large format images retrieved by Colortrac SmartLF document scanners into digital form and store
this on an attached computer - as easily as possible.

ScanWorks represents a revolutionary software approach to managing the scan to file process for large format scanning. Unlike most other
scanning software available today which use an „adjust and rescan‟ method to perfect settings for more difficult originals, ScanWorks can do
all this with a single scan by emulating scanner behaviour on the computer. When the scan has been adjusted on-screen the scan (which is
already on disk) is overwritten as the Save button is clicked. By activating the inline function these adjustments can be incorporated
automatically in all further scans or saved as a Preset. This not only saves valuable time and boosts productivity but it also reduces wear and
tear on the original document.

The concept of ScanWorks was arrived at by listening carefully to the needs of scanning professionals and continues to be enhanced
regularly to accommodate the constantly changing requirements of the large format scanning market.

“We hope that you too will find ScanWorks a pleasure to use.” – Peter de Winter-Brown (Sales & Marketing Director, Colortrac Ltd.)
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1.1

How to use this manual

The manual is divided into five Chapters

Chapter 1.

Overview (this section)
How to use this manual, the sections and coverage of the manual

Chapter 2.

Software Installation and Graphical Interface –
The ScanWorks system requirements, software installation from the Colortrac CD and the
ScanWorks Graphical User Interface with descriptions and locations of all the main controls

Chapter 3.

Making your first SCAN –
The steps to making your first Colortrac SmartLF scan

Chapter 4.

Advanced Scanning –
More Advanced Techniques – Image Controls

Chapter 5.

Appendix –
Notes on the hardware installation, USB2, data speeds and file sizes.

Help and Assistance:
Throughout this manual you will see that some text appears in shaded blocks. These areas provide assistance in the form of the
QUICKSTART TIP which is a summary of the main configuration steps, the TIP which is experienced based operator information for faster
and more accurate scanning and a NOTES heading where you can find further explanatory detail.
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2
2.1

ScanWorks Installation
System requirements for ScanWorks and SmartLF

Operating system
Processor
Memory
Data port
Monitor
Scanner

3,5

Windows Vista (Basic, Home, Premium, Business), Windows 7 or Windows XP
At least 2.8GHz, DUAL CORE (AMD), CORE-DUO (Intel), HT (Hyper Threading), 32-bit or 64-bit
processor
2GB or better for Vista, 1 GB for XP
USB2 compatible and / or gigabit network interface
Minimum of 1024 x 768 resolution running full, 24-bit or 32-bit color
SmartLF 4080, Cx 40, Gx 25, Gx 42, Ci 24, Ci 40, Gx+ 28, Gx+ 42 Gx+ 56

1. The scan rate is proportional across the full range of resolutions supported by the scanner. Actual scan times will depend on the host system performance.
Contact your supplier for advice on the optimum system configuration for your application. Colortrac Ltd reserves the right to change or amend specifications
without notice. Colortrac and Smart LF are trademarks of Colortrac Ltd. All other trademarks are the property of their respective owners. Copyright © 2009
Colortrac Ltd
2. The Microsoft .NET environment is a Windows Service Pack Update. .NET is necessary for operation of the SmartLF All-In-One software but is not a
requirement of ScanWorks
3. Windows 98, ME, NT4 and Windows 2000 Server are not compatible with SmartLF Ci 40 , Gx+ and later models of SmartLF scanner
4. USB2 & Gigabit are the minimum levels of interface specification for Colortrac scanners. Slower USB1.1 interfaces will cause slow scan speeds and possible
scanner malfunction. For Ethernet operation a 1000 Mbit/s (gigabit) Ethernet switch should be used between the scanner and a slower speed network.
Colortrac scanners will not function when directly connected to 10 /100 Mbit/s Ethernet equipment
5. Colortrac scanner drivers install automatically for 32-bit and 64-bit operating systems. ScanWorks is a 32-bit application and operates in emulation mode with a
64-bit scanner driver when used with a 64-bit computer
6. ScanWorks and SmartLF scanner drivers operate normally on a Mac Book Pro or Mac computer designed to support Windows applications and Windows
hardware drivers

Display settings: The graphics resolution should be set to 1024 x 768 or higher and color depth to full-color, 24-bit color or 32-bit. A 17”
monitor is the minimum size recommended for comfortable operation of the graphical user interface (GUI).
NOTE: Certain functions within CopySmart are not compatible with the SmartLF design and may appear grayed out.
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2.2

ScanWorks installation

These instructions assume that the Scanner Installation CD has already been used to install the scanner hardware drivers and perhaps the
basic SmartLF All-In-One software. Insert the ScanWorks Installation CD into the computer you intend to use with your new Colortrac
SmartLF scanner. If the Software Installation Disk splash screen does not pop up right away click the CD drive or right-mouse click the drive
letter and choose AutoPlay. Alternatively use Explorer to double-click the Launch.exe file in the root of this CD. Click the Installation tab and
follow the directions to install the license key (dongle) driver then the ScanWorks software. Finally insert the licence key and start ScanWorks
from All Programs‟ Colortrac folder.
NOTE: You will need to use Administrator privileges to first install ScanWorks. After installation, non-Administrator users will be able to use
ScanWorks but not remove or re-install the product.

8
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3

Getting Started with ScanWorks

The ScanWorks user interface has four
main areas.

1.

The scan configuration controls

2.

The overview window

3.

The editing control area

4.

The viewing desktop.

Scanner panel controls

ScanWorks Installation and Operating Manual V1.5
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3.1

Scan Configuration Controls

The Scan Configuration Control is split into the SCAN, PALETTES / FILE FORMATS, MEDIA HANDLING and DATA CONTROL tabs

Scan Configuration Controls (ScanWorks v2.4.7.1 shown)

3.1.1

Scan

Before a scan has been started only the Scan and Single or Batch toggle buttons are visible in the control area.

The green Scan button has three functions. During scanning the Scan button icon will change to display a red SCAN Stop icon. Pressing it
now will STOP the scanner. Work already displaying on the viewing desktop can be saved at this point. When the document has been
scanned the green Scan icon will re-appear with the Save and Delete icons alongside. At this point the user has three options; to press Save
and save the data, to press Delete and discard the data or to press Scan to Rescan the document again.

10
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SCAN (F9 from the keyboard)
The file has been named and the user is ready to start scanning. NOTE that
the Delete and Save icons are not present before the scan has been started.
All information in the view desktop is true image data at the resolution set up in
the scanner configuration controls. A full scan and not a prescan has been
made.
STOP (F10 from the keyboard)
During scanning, the scanner can be stopped by clicking the SCAN Stop icon
on the ScanWorks interface, or by pressing the STOP/FWD/EJECT button on
the SmartLF scanner.

RESCAN (F9), SAVE(F11) or DELETE (F12 from the keyboard)
When the scan has completed the user has the option to Rescan, Save or
Delete the current image on the viewing desktop

Until the Save button is pressed all Colortrac SmartLF scanners store scan data using a temporary file name. Pressing Save instructs the
operating system to apply the name provided by the user to scanned data. Because all of the data is already saved by the time the document
stops moving ScanWorks control is returned to the operator very quickly after the Save icon is pressed (except when the scan has been
modified post-scan).
TIP: The scanner model number and scanner firmware release is shown in brackets to the right of the word Scan on the first tab of
the scan configuration controls. This information will only be visible when the scanner is switched on and ready to scan.

ScanWorks Installation and Operating Manual V1.5
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3.1.2

Filename

Manual and Simple Increment

Press the

icon to manually name your file. This button also permits the operator to browse, create folders and even rename files via

the right-mouse click menu.

In single scan mode the Colortrac SmartLF scanner will require the user to input the file name before pressing Scan - unless the user starts
the automatic naming process by ending the name with a hyphen followed by a numeric sequence. For example a scan file name typed in as
bracket-03 and then Saved would cause ScanWorks to automatically generate the next file name as bracket-04. This will continue until
ScanWorks detects an identical filename in the same directory.
4-Tier Auto Increment

Press the

icon to configure automatic incremental numbering for your scan filename.

If you used the -nn file naming format above, pressing this icon will display the 4-tier file naming dialogue. Use this feature to create counterdriven names for your scan files. For example: contract-02drawing-49 can be generated by inputting the appropriate start and end point for
each counter. The counters work in a similar way to vehicle odometers except that the number at which any higher order counter will be
advanced is not limited to 10. This feature can be used with single scan or Batch scanning operations (see next section).
QUICKSTART TIP: Press the . . . icon and type a
name
UICKSTART TIP: Press the . . . icon and type a name
QUICKSTART TIP: Press the icon and type a name
12
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3.1.3

Paper Motion Controls
Pressing this button toggles ScanWorks operation between manual start scan mode and automatic start scan mode - often called
Batch scanning mode.

In Batch scanning mode ScanWorks will automatically begin scanning the second and all following

documents without the user pressing the Scan icon. The user only needs to load each document and ScanWorks will take over the
naming, saving and eject processes automatically. Batch Scanning is dealt with in more detail later in the manual.

SmartLF scanners are STOPPED from the scanner by pressing the RED button. In some
models this button also doubles as a BACK button that can be used to remove the
document from the front of the scanner. Press ScanWorks

to STOP the

scanner from the computer.

SmartLF 4080 has a multi-function STOP/FORWARD/EJECT button on the scanner itself which will stop the scanner if it is
scanning, move the document forward prior to scanning or eject the document if it has already been stopped. There is no REWIND
facility with SmartLF.
If ScanWorks shows the Scan button, and Eject buttons lit, then the scanner is ready to be used.
If the scanner is switched off or not connected to the computer, „No scanner attached‟ will be
displayed and the Scan button will be greyed out.
Scanner icon displayed during Batch Mode (automatic mode)

QUICKSTART TIP: Use manual start mode (not automatic batch mode) to begin scanning
ScanWorks Installation and Operating Manual V1.5
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3.1.4

ScanWorks Units of operation (mm or inches) – Preferences Tab

The Preferences Preset provides user access to:
ToolTips ..................... Balloon help giving basic guidance on the control or
button under or near the current cursor position
Units ........................... Set ScanWorks to Metric or Inches. All measurement
will display and require input using these units.
Temporary files path This is the location reserved for all temporary storage
required by ScanWorks.
Language.................... Language setting for ScanWorks
A language change becomes
effective after a program restart.
Scale to gray .............. For Black and White scanning.
Makes small detail visible when
viewing the whole drawing
onscreen.
Enable Scan logging.. Provides scan area, resolution
color mode and time stamping.
Batch statistics by scan and
color mode.
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Typical output from the ScanWorks scan statistics file (ScanLog.txt)
******************************************************************************************************
*
*
*
*
Tuesday, August 18, 2009 09:40:38
C:\Users\DeclanTyler.COLORTRAC\Documents\Scanworks\test-01.tif
19.91cm x 19.99cm @ 200dpi, RGB
Area = 0.04 square meters, Scantime = 00:00:05, Status = Saved
Tuesday, August 18, 2009 09:40:52
C:\Users\DeclanTyler.COLORTRAC\Documents\Scanworks\test-02.tif
19.91cm x 19.99cm @ 200dpi, Grayscale
Area = 0.04 square meters, Scantime = 00:00:03, Status = Saved
Tuesday, August 18, 2009 09:40:58
C:\Users\DeclanTyler.COLORTRAC\Documents\Scanworks\test-03.tif
19.91cm x 19.99cm @ 200dpi, Black and white
Area = 0.04 square meters, Scantime = 00:00:03, Status = Saved

Totals for Tuesday, August 18, 2009 09:40:22 through
Tuesday, August 18, 2009 09:41:05 (0 days, 0 hours, 0 minutes elapsed)
Total square meters: 0.12
Total saved scans: 3
Total rejected scans: 0
Total scans: 3
Total RGB scans: 1
Total 256 color scans: 0
Total 16 color scans: 0
Total Grayscale scans: 1
Total Black and white scans: 1
Total edited post scan: 0

******************************************************************************************************
******************************************************************************************************
*
*
The ScanLog.txt data file is located in the Program Files directory (XP) and C:\Users\USER\AppData\Roaming\ScanworksData (Vista)

QUICKSTART TIP: Always use the local hard disk as the temporary drive. Colortrac also recommend for all network based
scanning that scans be stored first locally and then transferred to the network afterwards.
ScanWorks Installation and Operating Manual V1.5
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3.1.5

Paper Size Controls
Standard size
Use the browse box to select the paper size closest to the size of the document you
are about to scan. Paper sizes larger than the physical document will be cropped on
length automatically by the scanner and can be width cropped by the operator as
required. Paper sizes set smaller than the physical document will capture this area of
the document from the point at which the scanner starts moving.
Automatic size
Check this button to have the scanner automatically detect the document size. Note
that for some compressed file formats a full prescan will be required prior to beginning
the scan. For most formats only a short document feed is used to find the width of
the document with the length detected as the scan completes. Automatic sizing is
recommended for use with side document justification only and not guaranteed
effective for all types of documents.

The scanner should be clean and well

maintained. Detection performance can be affected by torn or folded documents.
Specify size
Useful for non-standard paper sizes where automatic sizing may be too slow. Also
for fragile documents it can be better to specify a larger size and then manually crop it
using the editing tools rather than selecting Auto. Auto will prescan & partially rewind
the document to determine its width before scanning it.
QUICKSTART TIP: Change Paper size to Standard and select the same or next size up. Use the ruler when Specifying paper size
16
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3.1.6

Resolution

The Colortrac SmartLF family of scanners are based on three different optical resolutions – 400 dpi for the SmartLF 4080, 600 dpi for the Cx
40, Gx Range, Ci 40, Gx+ 56 and 1200 dpi for the Gx+ 28 and Gx+ 42. The optical resolution of a scanner represents the highest resolution it
can produce from actually „seeing‟ the data. Interpolated resolution uses mathematical calculation to estimate how the image might look at
resolutions higher than the optical. The process of extending the resolution beyond the optical resolution is referred to as „interpolation‟.

Scanner resolutions can be selected by the user usually from 100 dpi up to twice the optical
resolution (1200 dpi in this example). Higher interpolated resolutions can be generated using
the custom box up to a maximum of 3600 or 9600 dpi (depends on model) using interpolation.
High interpolated resolutions can place extra demand on computer resources.
* The minimum selectable resolution is usually 50 dpi

QUICKSTART TIP: Answer the question: “What is the minimum resolution I need for this scan?”
ScanWorks Installation and Operating Manual V1.5
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3.1.7

DataType
DataType describes how the color mode of the Colortrac SmartLF scanner is set. For
example as a full color device; a limited color scanner, a grayscale or a simple black
and white scanner. This is also known as the Color Depth of the image. All
Colortrac SmartLF scanners use 32-bit primary point data capture as the basis for all
color scanning.
RGB means full photographic quality color. This is sometimes referred to as 24-bit or
16 million colors.
256 colors (available as fixed or automatically derived). Useful for maps and
schematic drawings and posters where fewer colors can be used without degrading
the appearance of the image. Images created with this mode will be approximately
1/3rd the size of RGB scans (uncompressed).
16 color (available as fixed or automatically derived). Useful for maps where there are
only perhaps 4 colours. Images created with this mode are 1/6th the size of RGB
scans (uncompressed).
Grayscale creates 256 shades from white to black. This file will be the same byte
size as a 256 color file.
Black and White reduces an image to a single color, black. All other colours or
shades of gray are turned off or discarded. The level at which data is accepted is
called the threshold. Adaptive Thresholding is an advanced technique to deal with
large areas of original where there is low contrast making normal basic thresholding
less effective.

QUICKSTART TIP: Change DataType to RGB

18
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3.2
3.2.1

File Format / palettes
File Format

ScanWorks uses TIFF (Tagged Image File Format) as its default file format. This file format can be used to store digital scan information
from small binary black and white images (10-20MB) to large full color images (600MB plus). Not all formats are available for all color
modes. Clicking on the second tab, File formats / palettes, reveals an area where the file format for each DataType (Color Depth) choice
can be set. See the Appendix for more information on Turbo Mode.

Use the scroll button control at the
right-hand side of the DataType
boxes to pull down the formats
available. NOTE: TIFF is available
for all DataTypes.
The settings used in one or all of
these menus can be stored in
ScanWorks Presets.

QUICKSTART TIP: Change RGB Scan file type to TIFF
ScanWorks Installation and Operating Manual V1.5
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3.2.2

Palettes – Fixed (in-line processing)

The Palette section of the second tab is dealt with here and after File Format (3.2.1) because it is less important for users who are just getting
started with color scanning. Palettes enable a scanner to produce image files with fewer overall colors. A full color scan with16.7 million
colors is wasteful of disk space to capture a map with just 32 base colors. Fixed palettes assign the actual color in the original to the nearest
color in the palette. The fixed palette may often be unsuitable for a map with many similar colors. Colortrac SmartLF supports 256 and 16
fixed color palettes.

Note that the sea area of the map is speckled with blues of quite
different intensity. This is because the scanner is taking the color at this
point and forcing it into the best category it has. Fixed palette scanning
is most effective when scanning a set of documents for which a palette
has been derived automatically – see next section.
NOTE: Inline means processed during the scan.

20
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3.2.3

Palettes – Auto (in-line processing)

When the scanner is set for Auto palette the resulting scanned colors are much closer to the colors in the original. For best results a 16 color
map will need to be scanned using a 256 color palette because pure colors are never pure and begin to fade and change slightly over time.

Note that the scan color quality produced when the scanner carries
out an autopaletted scan is much better than the result from the
fixed palette scan. The scanner achieves this by first taking a lowresolution full color prescan of the original. From the prescan, it
analyses the colors to find out which ones are important and
considers their coverage of the image area. These details are then
processed to make the new optimized palette. The palette is then
used for the final scan at the resolution set by the user. The result
is a much closer and finely balanced image that is nearly as good
as full color but occupying 66% less storage space. Palettes
generated from an auto palette scan can be saved as the fixed
palette using the “Convert to” tool dialog. Useful for scanning
multiple documents that are similar such as quad maps. There is no
need to need to auto palette each one separately!
TIP: Always set DataType for 256 colors(Auto) or 16 colors(Auto) when using auto-paletting
ScanWorks Installation and Operating Manual V1.5
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3.3

Media handling

This tab controls whether the scanner should eject the media after the operator SAVEs or DELETEs a scan. It is also the tab where the speed
of the scanner can be controlled to match the performance of the computer. For the best scanning results, rapid stopping and starting of the
scanner should be avoided by lowering the speed setting of the scanner if required. This will not affect overall scan time and productivity.

End of scan behaviour
Rewind on Save/Delete ............ Varies between models
Eject on Save/Delete ................ After the scan completes clicking Save or Delete will Eject the document
Do nothing on Save/Delete ....... After the scan completes clicking Save or Delete will leave the document at its current position
Auto detect end of media .......... Available when Do nothing selected. The scanner will detect the end of the media and stop the media.
Justification
Center

Varies between models. Some models do not support center scanning. For use of Autosize with side and
center document justification see section 3.1.5
Side .......................................... Scan from the side of the scanner (good for smaller documents). Changes side depending on model
Staging ..................................... Adjustable from the Utilities programs

22
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Speed
Speed 1 .................................... (slowest)
Speed 8 .................................... (fastest)
Alter the scan speed if necessary to keep the scanner running continuously and to avoid stop/ start scanning
which can lead to poor image quality through the production of image artefacts, blurs or spectrum effects.

Auto load delay ......................... Adjustable from within the Utilities programs where supported
Disable auto load

Not adjustable/ available in SmartLF

QUICKSTART TIP: Click „Do nothing‟

ScanWorks Installation and Operating Manual V1.5
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3.4

Data control (the scanner internal settings)

This tab provides control of Brightness, Gamma and selection of raw RGB scanning or sRGB (standardized RGB) scanning. Use of sRGB
provides corrected color output suitable for standard Windows peripherals like monitors and color printers. Certain colors may scan better
with sRGB turned off.

Brightness .................. Controls the amount of white in the scanned image (default value depends on the scanner model)
Gamma ....................... Controls the depth of the colors seen by the scanner (default values for Ci 40 are 1.7, 1.7, 1.7 for R G and B)
NOTE: The scanner Brightness and Gamma settings are not intended to be changed regularly by the user and have
been set to the optimum values for the machine.
Calibration
White Balance .............
Normalisation ...............
Auto Stitch ...................
Scanner Utilities programs now perform or replace most of these tasks in a program external to ScanWorks.
Manual stitch ...............
Adaptive Stitch .............

No longer used

QUICKSTART TIP: Use with sRGB turned off for maximum color gamut
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3.5

The Thumbnail Window

ScanWorks will always make the scanned image fit the Thumbnail view window. At the same time ScanWorks will begin to display the same
scan data filling the Desktop window. If the Zoom in controls under the Overview window are used the image displaying in the Desktop
window will enlarge but the image size in the Overview window will not change. After the first zoom a red rectangular Zoom Indicator will be
displayed in the Overview window indicating the section of the main image which has been enlarged and now fills the Desktop window. As
the zoom is repeated the Desktop view becomes +larger while the Zoom Indicator shrinks.

1:1 zoom

No magnification (1 pixel in the file is displayed as 1 pixel on the screen)

Fit to Window

Fits the image to the window (sometimes call zoom extents) – default zoom

- zoom

Reduce magnification or zoom out (Zoom indicator gets larger)

+ zoom

Magnify the image or zoom in (Zoom indicator gets smaller)

Loupe

Use to magnify the scanner image in the desktop viewer window

Hand pan icon

Move in any direction.

Zoom Indicator pan

Right-click the zoom indicator and drag to pan across the scanned image
(fastest pan method).. Also click and drag out a square (marquee) in the
thumbnail view window to have that part of the image display in the Viewing
Desktop window.
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4

The Viewing Desktop

The ScanWorks Viewing Desktop window is a „Live‟ view of the original image at the resolution set in the scan configuration controls. This
means that the scan can be inspected for completeness (no missing edges) in the first view of the original as it appears onscreen. Next it can
be viewed at 1:1 to very rapidly quality check the image – all in one single operation. This is a Colortrac SmartLF productivity feature.

All scan data is directed immediately to the viewing
desktop where it can be inspected, cropped, rotated
or deskewed using the Editing Controls.

Use the horizontal and vertical sliders at the sides of
the Viewing Desktop to navigate around the scanned
image. Alternatively, click the

control below the

thumbnail view to activate the hand-panning tool.
The Zoom controls can be used with the handpanning tool.
Use the hand pan to move the zoomed image in any
direction. Use the left click to zoom in and the right
click to zoom out.

TIP: Use the top pull-down Window menu to arrange multiple scans on the Viewing Desktop – tile vertically, horizontally or cascade
26
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4.1

The ‘Loupe’ and screen display modes
The Loupe tool permits the operator to quality check the scan
as it first appears with greater freedom to change the zoom
using the right-click of the computer mouse. It can be moved
over the full image and the zoom altered by clicking the right
mouse button. Toggle the Loupe icon to turn this feature ON
and OFF.
The Loupe window can be resized by dragging the edge
of the circle. The loupe window will also display what
ever is beneath the cursor when the cursor is positioned
outside of the loupe window.
The main viewing desktop can be switched to fill the whole
screen by clicking on the small arrows in the view window left
margin. Clicking the same arrows again, (toggling) will
restore the viewing window to the Standard display size with
the full editing and file controls visible.
Top graphic shows the Loupe magnification set to 200%
Lower graphic shows ScanWorks set for Full Screen display
mode. Clicking the arrows in the left border toggles each
display between Standard and Full Screen mode.

View Controls available in Full Screen Display Mode
ScanWorks Installation and Operating Manual V1.5
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5

The Tabs inside the Editing Controls Area

Presets

Clicking this tab reveals the Presets available. These can be altered and deleted by the user as required.

Controls

This tab brings up the Editing controls relevant to the currently selected color mode or DataType of the scanner
(for example Full Color RGB, Black and White, Grayscale or Indexed Color).

More Controls

This tab reveals further controls for running external editors and indexing programs as well as the Color
Classification module of ScanWorks for color separation and feature extraction.

Preferences

Use this tab to set the units used inside ScanWorks, the Language, the location of the temporary files, the Tool
Tips status and to enable/ disable Scale to gray.

Connection setting

Switch between USB2 and Ethernet connection for ScanWorks. See scanner installation manual for more details.
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6
6.1

Editing Control Area (color and image editing controls)
Filters and controls for RGB and Grayscale

These controls allow the scanner operator to alter the RGB or Grayscale image shown in the Viewing Desktop Window WITHOUT
rescanning the document. The operational concept behind ScanWorks is that the image can be edited in front of the user as required and
then if necessary these changes can be made automatic (or „IN-LINE‟) for all subsequent scans. Examples of IN-LINE editing can be simple
operations like Rotation and Inversion of the image (changing white to black and black to white) to more complex operations like Sharpening
or altering the Black and White Points.

NOTE: Sharpening and De-noise
filters are only relevant for full color
(RGB / 24-bit) and grayscale
scanning modes. ScanWorks may
display different or fewer tools for the
other scan modes.

Sharpening
Blur

Improve the focus of text and fine lines. Start with +1
Soften the focus of photographic details

Noise
Removal

Remove spurious effects and image aberrations. Particularly

RGB Controls

Alter the intensity of R G and B using color curves

Contrast
Brightness

Increase / decrease image contrast
Increase / decrease image brightness

White point
Black point

Combines the white end of the spectrum
Combines the black end of the spectrum

Deskew

Adjust the image to line-up horizontally or vertically
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Filters and controls for RGB and Grayscale contd.
Grayscale is very similar to full color or RGB 24-bit when a single color channel is considered. Full color scanning uses the Red, Green and
Blue channels each with 256 levels. The grayscale scanning mode uses 256 levels but using a single „color‟ K or black channel. In the
Colortrac SmartLF scanner grayscale can be generated by using the output from all three R,G and B cameras or by just using the K sensor
(model dependant).
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Rotate image

Rotate through 90, 180 or 270 degrees

Crop image

Delete unwanted border data from the image

Mirror

Mirror the mage about the y-axis

Color Depth
Reduction

Change 24-bit to 256 to 1 bit (binary)

Resample

Reduce the resolution of the scanned image

Invert

Change white for black (blueprint scanning)
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6.2

Filters and Controls for 256 color (or indexed color)

When ScanWorks is being used with the scanner in 256 or 16 color the Sharpening and Noise Removal filters are NOT available

The sharpening and noise removal filters only work with RGB (24–bit full color) or grayscale scan data

6.3

Filters and controls for 1-bit color or Black and White (binary color)

When ScanWorks is being used to run the scanner in Black and White mode some of the color only filters will disappear from the tool group.
Black and White scanning introduces the Despeckle and Dynamic Threshold controls (see below)

Despeckle .......... Remove isolated pixel groups (speckles)

Dynamic ............. Produces Black and White scans by processing grayscale
thresholding
data in the computer using Basic or Adaptive thresholding
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7
7.1

Making your first SmartLF SCAN
Checking the settings

ScanWorks settings checklist

Scanner checklist

Scan icon is green inside ScanWorks
Paper sizing = Standard, size = A4 portrait
Resolution = 200 dpi
End of scan = Do nothing
Filename = TEST or similar
Speed = Fast (*)

Check the scanner is on and displaying the word READY
Load a document face down in the scanner.

(*) denotes default setting

7.2

Saving your first Preset

The Preset option in ScanWorks is provided to allow
the user to capture any mix of settings. It is useful
practice to save these settings now so they can be
reloaded at any time during the scanner familiarization
and training period.
Note that whenever ScanWorks is closed it will reload
with the settings that were in use when it was
shutdown. If the program terminates abnormally, no
settings will be saved. Reloading this Preset will restore
the settings shown above.

All saved Presets can be listed by pressing the Presets tab in the editing controls
32
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area. As the user changes to other presets the ScanWorks settings linked to that
preset alter in the ScanWorks interface. Once selected the database details for
Image type, Media, Condition and Scan are displayed in the lower panel.
The Labels in any preset can be changed to reflect the nature of the scanning
work being carried out by selecting the existing text and re-typing a new label.
Presets can be changed by selecting the Preset, making the ScanWorks setting
changes and selecting Save current settings as preset in the ScanWorks File
menu.

7.3

Starting the scan



Place the document on the scanner to the right-hand side of the paper tray, face down with the top of the document nearest
the rollers and allow the document to load.



Now using the cursor, click the SCAN




Review the image shown in the viewing desktop
If the image is OK press the Diskette icon (or F11) to save the image. The document will remain gripped in the
scanner. For production scanning change the End of scan setting to „Eject‟

button or press F9 on the keyboard to begin scanning.
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The SCAN Workflow

SCAN REQUIRES CROP OR
EDITING OPERATION
(OPTIONAL)

SCAN / F9

STOP/ F10 or
press SCAN
button again

?
DISCARD SCAN
(NAME RETAINED)
ADJUST SETTINGS / CHANGE
DOCUMENT (NAME RETAINED)

DELETE OR DISCARD / F12
SAVE SCAN
TO DISK

SAVE SCAN
TO DISK

SAVE / F11

SAVE / F11

34

ScanWorks Installation and Operating Manual V1.5

Advanced Scanning

The BATCH SCAN Workflow

SCAN / F9

?
PAUSE/ EDIT
CANCEL (FINISH)
BATCH

INTERRUPT SCAN FOR
CROP OR EDITING
OPERATION
(OPTIONAL)

SAVE SCAN
TO DISK

SAVE / F11

SCANNER
AUTO LOADS AND
AUTO SAVES
DOCUMENTS PLACED
IN SCANNER

CURRENT SCAN
DISCARDED AND
SESSION ENDED
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8

The ScanWorks Pull down menus
................................................. Open any previously saved scan file
................................................. Close any current file (after editing or reworking)
................................................. Save current file to a NEW OR DIFFERENT NAME

................................................. Use the Batch utility within ScanWorks
................................................. Add to or Delete the files used in the Batch process
................................................. Run the Batch
................................................. Run Batch without ScanWorks
................................................. Save ALL current settings to a User PRESET
................................................. Use current scan as an email attachment
................................................. Send current view to the Windows printer
................................................. Configure the Windows printer for printing current view
................................................. Last scans loaded

................................................. Leave ScanWorks

36

ScanWorks Installation and Operating Manual V1.5

Advanced Scanning
UNDOs are multiple and operation sensitive. This means they change to reflect the type of
editing operation currently being undertaken.
For example UNDO Deskew
Crop
Rotate
Mirror
Sharpen
Blur
Type conversion (reduce to fewer colors)
Reduce resolution
NOTE: To undo a recent RGB or black-white adjustment (to the brightness or RGB curves) the RESET button on the tool dialogue must be
used. If a scan has been made with a tool active as an inline device IT CANNOT BE UNDONE. Scans in this case will need to be
rescanned with the relevant tool switched off.
The Window Menu provides access to:
.......................................................................... Cascade the scans inside the Viewing Desktop
.......................................................................... Tile horizontally all scans inside the Viewing Desktop
.......................................................................... Tile vertically all scans inside the Viewing Desktop
.......................................................................... Line up minimized scans inside the Viewing Desktop

.................................................................... About: Version number of ScanWorks
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9

Scanner Maintenance

9.1

Light warm-up period

SmartLF 2D LED illumination (Gx+ range) or the integral LED light source in CIS equipped scanners is ready to go within 6 seconds from
power-on and no warm-up or stabilization is required. All later models of SmartLF have power economy circuitry and are Energy Star rated.
Older style SmartLF Gx 42 scanners using fluorescent tubes for illumination must be warmed up for at least 30 minutes before use for best
scan performance.

9.2

Calibration

The normalisation and colour calibration for Colortrac SmartLF are set at the factory and maintained automatically by the scanner internal
circuitry. No user intervention is required for these operations. There are no calibration consumables.

9.3

Cleaning the scanner glass

Occasional cleaning of the scan glass will be required for SmartLF. The scan glass is a chemically hardened scratch resistant material which
should last much longer than regular scanner glass but can be replaced as a service consumable if/ when required. For Ci 40 see the
Installation Manual or consult your supplier.

9.3.1

Stitch Procedure

Stitching for SmartLF is factory set at manufacture and maintained electronically by the operator when necessary using the Utilities programs.
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10 More Advanced Techniques – Image Controls
The Inline (Auto) and Reset buttons - IMPORTANT
The unchecked INLINE button. Each edit function has its own Inlne (Auto) button. Checking this button causes
ScanWorks to automatically apply the tool in real time or at the end of the scan.

The checked inline button means that automatic editing is ACTIVATED and ScanWorks indicates the ACTIVE
control using a green or yellow outline border. A green border indicates processing during the scan. A yellow
border means the action is applied automatically after the scan has completed.

An activated Sharpen / Blur control

An activated Rotate control (rotation is carried out after the full image is scanned). Inline (post) button
displays a red bar

An often overlooked control, the RESET button is more than a simple slider reset. Clicking this button adjusts the
size of the Crop Box and Deskew tools to suit the current zoom.
The images to the right show the
Crop Box before and after
resizing to suit the current Zoom.
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10.1 Sharpen / Blur
The Sharpen / Blur Control set for
Sharpen1. This control has a 1:1 Preview
button which can show the user how the
image can expect to look after the filter
has been applied on the portion of the
image visible in the viewing window (auto
zoomed to 1:1).
When the required amount of filter has
been found the Sharpen / Blur button is
clicked to process the whole image. The
image will now need to be saved to store
the Sharpened form of the image.
The „enabled‟ but borderless „A‟ icon tells
the ScanWorks operator that the tool is
being applied interactively.

Notes / recommendations:
For the Sharpen control use a setting of 1 to
bring up 200 dpi maps to a sharper more
focussed result without the disk space
implications of using a higher resolution.
Blurring affects all detail in a scan.
Sharpening is effective at 1:1 and low zooms for
example copies

The green INLINE button and green
border around The „A‟ button indicate that
the filter is being applied during the
scan.
This is a „Virtual Scan Tool‟ and when
used offline this edit tool produces the
same effect as when used „Live‟ during
the scanning process. In manual use, the
result of the edit replaces the image
shown in the viewing window.
Normal
40

Blurred –1

Sharpen +1
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10.2 Noise Reduction
The Noise reduction Control set for 3x3.
This control has a 1:1 Preview button
which can show the user how the
image can expect to look after the filter
has been applied on the portion of the
image visible in the viewing window
(auto zoomed to 1:1).

When the required amount of filter has
been found the De-noise button is
clicked to process the whole image.
The file will now need to be saved to
store the De-noised form of the image.
The
„enabled‟
but
borderless
„Waveform‟ icon tells the ScanWorks
operator that the tool is being applied
interactively

Notes / recommendations:
Use where there are print screening problems –
usually where the resolution of the scanner
„interferes‟ with the resolution of the printed
original.
Maintains detail and removes screening
patterns without losing sharpness.
Use of this control in-line will slow down
scanning depending on the resolution used.

The green INLINE button and green
border around The „Waveform‟ button
indicate that the filter is being applied
during the scan.
This is a „Virtual Scan Tool‟ and when
used offline this edit tool produces the
same effect as when used „Live‟ during
the scanning process. In manual use,
the result of the edit replaces the image
shown in the viewing window.
Blur –1

DeNoise 7

Normal
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10.3 RGB Curves Editing
The RGB Curves Editor. This can be
used to control the intensity of the
primary scanner colors of Red, Green
and Blue. This control Previews the effect
of altering the curves in real-time and
updates the image in the viewing window.
When the required amount of filter has
been found the image can be saved to
store the effect of the filter on the original
image.
The „enabled‟ but borderless „Curves‟
icon tells the ScanWorks operator that
the tool is being applied interactively.
This is a „Virtual Scan Tool‟ and when
used offline this edit tool produces the
same effect as when used „Live‟ during
the scanning process. In manual use, the
result of the edit replaces the image
shown in the viewing window.

Notes / recommendations:
This control can be used to increase the color
saturation of the image being scanned or in the
editor.
The characteristic „S‟ curve is often used to
strengthen colors in a scan.
To apply the setting manually to a scan „click‟
the slider control or curve grips.
Use this control with a single color selected to
change the intensity of this color in the scan.
For example remove blue or increase red to add
warmth to an image.

There is no inline or „during scan‟
operation for this control
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10.3.1 Using the ScanWorks RGB curve editor

Neutral RGB

Saturation

OU
T

IN

Linear filter setting applies
no changes to the red,
green and blue signals.
There is no increase or
reduction in the gamma of
the scan data. Alter the
RGB values as a group or
individually as red, green or
blue

De-saturate

OU
T

IN

The curve is dragged low
to increase the saturation
of all colors. Note how
the
background
has
darkened and the lighter
shades are now lost as
the midtones are lost.

S-curve

OUT

IN

OU
T

IN

For a low input there is
high output. This will
mean a movement of the
colors to white as the
red, green and blue
signals get larger (nearer
255). Weaker colors get
brighter

Used to lighten the
background and the lighter
colors while improving the
contrast and general color.
Colours in the mid tones
are boosted. Very light
and very dark colours are
not affected much
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Using the ScanWorks RGB curve editor continued . . .

44

Neutral Red

Low Red

High Red

Low Green

The red channel is selected
as the channel to be
adjusted. The green and
blue channels will not be
affected by any adjustments
to the red curve

The red curve is dragged
low to reduce the red
components of the scan

The red curve is dragged
high to increase its
intensity allowing it to
dominate over blue and
green

The green curve is
dragged low to reduce the
green component s of the
scan.
Blue and red are stronger
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10.4 Brightness - Contrast
The Brightness and Contrast slider pair.
This control Previews the effect of altering
the sliders in real-time and updates the
image in the viewing window.
When the required amount of filter has
been found the image can be saved to
store the effect of the filter on the original
image.
The „enabled‟ but borderless „BrightnessContrast‟ icon tells the ScanWorks operator
that the tool is being applied interactively

The bright-green INLINE arrow and green
border around the „Brightness-Contrast‟
button indicate that the filter is being
applied during the scan.
This is a „Virtual Scan Tool‟ and when used
offline this edit tool produces the same
effect as when used „Live‟ during the
scanning process. In manual use, the result
of the edit replaces the image shown in the
viewing window.

Notes / recommendations:
The Brightness control can be used to
bring out shadow information. It can
also be used to compensate for
ageing tubes in the scanner as the
scanner gets older.
Contrast will take out subtle
information leaving only the strong
colors

A filter although SET will not be active
for any scan unless the INLINE arrow
or green border are showing. To
apply the setting manually to a scan
move the slider control(s).
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10.4.1 Using the ScanWorks Brightness / Contrast curve editor
Brightness controls the amount of white in a scan. Contrast controls the tonal quality of an image

Brightness High

High brightness moves
every color towards white
and effectively puts more
white into the images

46

Brightness Low

Low brightness takes
white out of an image and
makes the image much
darker. This is not the
same as saturating or
decreasing the gamma

Contrast High

Contrast exaggerates
the divisions between
colors by removing any
tonal quality. Colors
move towards their
primary state – C M Y K
R G B and Black

Contrast Low

Low contrast softens the
divisions between colors
eventually making the
entire image gray
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10.5 Black / White point
Showing the Black Point control set to 194 and
the White Point control set to 15. These
controls Preview the effect of altering the sliders
in real-time and will update the image in the
viewing window.
When the required amount of filter has been
found the image can be saved to store the
effect of the filter on the original image.
The „enabled‟ but borderless „Black+White dot‟
icon tells the ScanWorks operator that the tool
is being used by the operator interactively.

The bright-green INLINE arrow and green
border around the „„Black+White dot‟ button
indicates that the filter is being applied during
the scan.
This is a „Virtual Scan Tool‟ and when used
offline this edit tool produces the same effect as
when used „Live‟ during the scanning process.
In manual use, the result of the edit replaces
the image shown in the viewing window.

Notes / recommendations:
Use White-point to remove unwanted offwhite backgrounds from scans.
Use Black point to increase the purity of
black information in scans. Be careful not to
over use as they will increase the harshness
of an image if used excessively.

A filter although SET will not be active for
any scan unless the INLINE arrow or green
border are showing. To apply the setting
manually to a scan move the slider
control(s).
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10.5.1 Using the Black – White Slider
For grayscale and full color images. This control collects grays and off-whites together.

Low White Point

White Point can be used to
remove background
grayness. Note the light
shades are lost in the
center of the image
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High White Point

Aggressive White point
will remove all the lighter
shades because they
have a large white value

Low Black Point

High Black Point

A low Black Point can be
used to darken black
detail, however it can
sometimes make text
appear blocky and
unnatural

A high Black Point groups
all colors except the lighter
shades.
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10.6 Deskew
The Deskew Control set for 0.54
degrees. This is an interactive control
and requires the operator to identify the
longest horizontal or vertical line in the
image and for them to place the Deskew
marker ends onto each end of the line.
When the required amount of deskew
has been found the Deskew button is
clicked to process the whole image.
The file will now need to be saved to
store the Deskewed form of the image.

The direction of the deskew rotation is
determined automatically by ScanWorks
but can be entered manually (overidden)
by the operator
Deskew is interactive and must be
carried out by the operator.

Notes / recommendations:
Use where the image is not oriented
perpendicular to the viewing window.
Where possible always re-scan the
document instead of carrying out a deskew.
If you must deskew the image and need to
refine the process do not deskew an already
deskewed image - always UNDO a deskew
and start again for a better final result.
ScanWorks does not support anti-alias
deskewing and some post-deskew image
irregularities may be visible at high zoom
factors.

Press to re-size Deskew
reference line to fit current
zoom
TIP: At minimum zoom, roughly stretch the ends of the deskew tool to each end of the longest horizontal or vertical line in the
image. Now zoom into the drawing over one end and affix the deskew marker. Now, by making a right mouse click, drag the
thumbnail area of interest to move the zoomed area along to the opposite end of the line being used as the deskew reference.
Affix the second marker. Finally click the deskew button to complete the deskew.
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10.7 Rotate
The Quadrant Rotate Control set for 90
degrees clockwise.
This function can be set INLINE (by clicking
the green arrow) to automatically rotate
every scan image. The graphic left shows
this feature in manual mode.

The „enabled‟ but borderless „icon tells the
ScanWorks operator that the tool is being
used by the operator interactively.

The bright-green INLINE arrow with the
RED bar above and yellow border around
the „Rotate‟ button indicates that automatic
image rotation has been selected. Note:
Rotation in fact occurs automatically directly
after the scan finishes (yellow outlined
square).
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Notes / recommendations:
Use to rotate an image. Useful to rotate by
90 degrees A0 drawings which are being
scanned SEF (short edge first) in the
scanner. After processing, rotated drawings
will present LEF (long edge first) or
landscape in the viewing window.

Use of this control in-line can slow down the
overall scan time depending on the
resolution used. The speed of this process
is also affected by choice of file format.
Compressed file formats (for example
TIFG4) will take longer to process.
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10.8 Crop
The Crop Box
This is a realtime manual
control and performs the
conversion in the viewing
window.
When the required amount of
crop has been decided upon
the operator presses Crop to
cut away all image data
OUTSIDE of the crop margin.
The „enabled‟ but borderless
„Crop‟ icon tells the ScanWorks
operator that the tool is being
used interactively.

Notes / recommendations:
Use to quickly clean up irregular edges of
any scan. If you crop too much you can
undo with ScanWorks – how many times will
depend on the memory in the computer.
Remember to use the RESET button to
resize the Crop Box and grips to fit your
zoom instead of manually zooming out to
find them.
TIFG4) will take longer to process.

This tool is NOT available as
an automatic feature.
Press to re-size Crop box to fit
current zoom
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10.9 Mirror
The Mirror Control
This is a realtime manual control and
performs the conversion in the viewing
window.
This is a „Virtual Scan Tool‟ and when
used offline this edit tool produces the
same effect as when used „INLINE‟
during the scanning process. In manual
use, the result of the edit replaces the
image shown in the viewing window.

Notes / recommendations:
Use for transparencies where the „printed‟
side closest to the sensors during scanning
must be revolved about the y-axis.

The „enabled‟ but borderless „Mirror‟ icon
tells the ScanWorks operator that the tool
is being applied interactively.

The bright-green INLINE arrow and green
border around the „Mirror‟ button
indicates that the filter is being applied
during the scan.
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10.10 Convert to . . .
The Convert to Control set for 256
colors.
Step down to file formats with lower
Color Depth or fewer colors. If the
image showing in ScanWorks was
scanned in RGB then all of the
shown reductions will be possible.
The Color Depth may be changed
in steps manually (always towards
the fewer color version) or by
skipping intermediate levels if
required as an inline process.
The „enabled‟ but borderless
„Checker‟ icon tells the ScanWorks
operator that the tool is being used
by the operator interactively.

The bright-green INLINE arrow with
the RED bar and the yellow border
around the „Checker‟ button
indicates that the filter is being
applied after the scan.

Notes / recommendations:
Use to convert Full color scans to files with
fewer colors to reduce file size.
Use to change color scans to grayscale.
Use to change grayscale scans to binary
(black and white)

Use of this control in-line will incur extra
processing time after the scan and depends
on the resolution used and the size of the
image.

This is a real-time manual control and
performs the conversion in the viewing
window.

TIP: Conversion allows colour scans to be reduced to files of fewer colours and smaller byte
size at medium to high resolution and is suitable for maps, schematics and similar. Not effective
for photographic images where it is preferable to reduce the resolution and use JPEG or
JPEG2000 to reduce scan file size instead.
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10.11 Resample
The Convert to Control set for 256 colors.
Step down to lower resolutions to reduce
the file storage size of the scan.
Resample is not available as an offline
function and must be carried out by the
operator.

The „enabled‟ but borderless „Checker‟
icon tells the ScanWorks operator that
the tool is being used by the operator
interactively.

Notes / recommendations:
Use to make smaller file sizes. Use this
feature to produce scans for wordprocessing documents where high zoom/
close-up detail is not required.

This is a real-time manual control and
performs the conversion in the viewing
window.
window.

TIP: Resampling a scan from 400 dpi down to 72 dpi will reduce the byte size (the area) of any scan by a factor of 72/ 400 x 72 /
400 or 0.032. The physical dimensions will be approximately 0.18 of those previously in each of the axes. For scans intended to
be viewed on a monitor, 72 dpi is a good general resolution which maintains both legibility and keeps the storage size of the
document to a minimum.
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10.12 Invert
The Invert Control.
Use this control to move any shade of
black through white to the opposite end
of the gray spectrum. Turn blacks to
white and white to black.
This is a „Virtual Scan Tool‟ and when
used offline this edit tool produces the
same effect as when used „Live‟ during
the scanning process. In manual mode,
the result of the edit replaces the image
shown in the viewing window.

Notes / recommendations:
Use where the scan is produced the wrong
way around in a black and white sense. For
example engineering blueprints where the
background will scan as black and the
foreground or line information as white.

The „enabled‟ but borderless „Invert‟ icon
tells the ScanWorks operator that the
tool is being used by the operator
interactively.

The bright-green INLINE arrow and
green border around the „Invert‟ button
indicates that the filter is being applied
during the scan.
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11 Monochrome scanning – Interactive Dynamic thresholding
The Colortrac SmartLF scanner is an excellent monochrome scanning device. Monochrome scans are very small in storage format terms and
can occupy as little as 250 Kbytes for an A0 1189 mm x 841 mm drawing when compressed using 2D TIFF Group 4 compression.
Engineering plans and drawings are converted into raster format and emailed rather than sending a hard copy. TIFG4 is also a very common
file format and compatible with most viewers such as Kodak Imaging, Paint and many others.
Select :

DataType = Black & White or Black & White Mono (high speed Green channel mono)
Resolution = 200 dpi
Notes / recommendations:
The Black & White Threshold Control
Use to produce very small binary files
This is a „Virtual Scan Tool‟ and when used
which store only ON (binary 1) or OFF
offline this edit tool produces the same effect as
(binary 0) data.
when used „Live‟ during the normal scanning. In
manual mode the result of the edit replaces and
continually updates the image shown in the
Use Basic Thresholding for clean
viewing window.
drawings with no background noise or
dirt.
The Black and White thresholding control can
be set to produce Basic, Dither or Adaptive
Use Adaptive Thresholding for drawings
output. Black and White Thresholding is a filter
where the background density
that works permanently to produce BW data in
approaches the foreground (lines) and
the scanner or in the computer.
When
contrast between the two is poor.
thresholding is selected for in computer
ScanWorks (termed “Post-scan threshold)
Do not assume Adaptive thresholding is
provides
interactive
control
over
the
always best. Do not leave it switched
thresholding levels for Basic and Adaptive
on for clean drawings.
methods.
„Virtual
Thresholding‟
permits
optimization of the image while only needing to
scan ONCE.

TIP: Post–scan thresholding or in-computer thresholding allows INTERACTIVE adjustment without rescanning
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11.1 Adaptive Thresholding in Black & White.
1.
2.
3.
4.
5.

Enable Post scan threshold in the top of the Black and White controls dialogue
Select Adaptive. Post scan thresholding causes grayscale data to be returned to the computer.
Raise the Window and Background controls to minimum effect (move both sliders to the right)
First increase the Background darkness to bring up any feint detail (graphic left)
Second reduce the Window size to sharpen up lines, increase contrast and remove area discoloration (middle graphic)

Window = 250
6.
7.
8.

Window = 64

Increase the background darkness until speckles begin to appear
Choose a difficult area of the drawing and check that the Window setting is
optimum
Save these settings as a Preset, Save the file and resume scanning.

TIP: Too low a Window setting will begin to outline block data and remove the center
of any filled area – even arrowheads. It will also make text look feint and of poor
quality.
TIP: For greater scanning speeds after scan settings have been established
interactively, enable processing in the scanner by unchecking the „Post scan
threshold’ button.

Window = 10
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11.2 Basic Thresholding in Black & White
1.

Move the slider first to the right and then make the image darker by moving it to the left to bring up
detail in the drawing.

NOTES: Basic thresholding will apply a uniform threshold across the whole drawing. This will not be
suitable for all drawings especially those with a non-uniform background such as blueprints, Diazo
copies and badly reproduced originals. Note that copies from digital plain paper copiers are electronic
binary copies and so may not respond as expected to the adaptive thresholding process.
Basic thresholding may not allow drawings that have regions of low contrast to be scanned effectively
(see graphic below).

Scale-to-Gray is a feature that improves the view of the scan when seen zoomed out in the
view window of ScanWorks. As the user zooms into the image the grayscaling gives way to
the pure binary of the true image. Without this feature, lines may appear to be missed from
the scan when seen at full zoom.

TIP: Basic thresholding produces the best results for scanning clean drawings.
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11.3 Dithered Thresholding in Black & White
1.

Select Dither and then move the slider first to the right, then move it to the left to bring up more
detail in the drawing.

NOTES: Dither responds differently from Basic or Adaptive thresholding and provides a gradual
increase in the amount of detail seen in the drawing as the slider is moved to the left. Dithered output
produces a binary file that can be stored in the compressed TIFG4 format. As the background level is
increased, more black pixels are used. Increasing the background still further moves pixels closer
together. A Dithered black and white file will be much smaller in file size than the same drawing held
in the grayscale format although can be almost as useful.

TIP: Although the image may appear weak on the screen there will be a significant improvement in
the information visible when the image is printed out on a black and white printer.

TIP: Sometimes very feint lines in a drawing may fail to be revealed using conventional Basic
thresholding. This is where Dither Binary can be very effective.

Dithered threshold image

Grayscale image

Dithered image
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11.4 Despeckling with Black and White scanning
Despeckling is a process used to remove isolated areas of black pixels after a scan has been
scanned in black and white. The control works by removing any group of pixels whose largest
pixel dimension is LESS than the size set in the despeckling dialogue. Despeckling is closely
related to the quality of the thresholding, particularly the setting of the Background level.
Certain drawings are best left with some background speckles or Noise after thresholding and
these can be cleaned using the despeckle function. This command affects the entire loaded
image.
Post scan threshold – In this mode use of the despeckle command prevents any further
interactive thresholding of the scan. Despeckle can still be increased and undone (top menu
Undo command) multiple times. It is normal to despeckle as the final operation. Changing the
threshold will change the requirements of any despeckling operation.
In-scanner threshold – Despeckling in this mode behaves as above and just like a regular noninteractive scanner. To change the threshold the document must be re-scanned.
ScanWorks supports multiple UNDO which means that if too many pixels are removed the
process can be undone back to a less aggressive level.
TIP: Care must be taken not to set the despeckle level higher than the size of the smallest decimal point, dots or other vital information in the
scan image or these will be lost and could make the scan useless. Right click and drag a selection rectangle around what you consider to be
a „speck‟. The actual size will auto populate the speckle size box eliminating guesswork.

No Despeckle
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Despeckle = 5

Despeckle = 15
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12 4 -Tier Auto Increment File Naming
This feature of ScanWorks allows the Colortrac SmartLF user to create more complex file
names for scans based on an auto increment and roll-over system. Normal incremental
file naming is activated by using a filename-nn construction. Entering Project-08 as
the filename in the normal way and then pressing the ID button will reveal that the name
can increment to a max value of 99 in steps of 1 as expected.
This can now be expanded further by adding more information through the ID dialogue
and using the increment parameter and max and min values. For example:
Primary name
Secondary name
Project-08 Electrical even numbers-04
Secondary counter

Primary counter
Counter Indicator (use single character -* + = $)

NOTE: The increment control checkbox must be clicked to force Counter 2 to advance
Counter 1 when it reaches its max value. If left unchecked all numbers will increment by their
respective settings for every scan made. The start value becomes the minimum value. Place
the Counter Indicator immediately before the numbers you wish to control.
TIP: Do not use the slash / as the Counter indicator in the file sequence
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13 Printing from ScanWorks
ScanWorks supports any normal Windows printer driver through the File>Print Current View and File>Print Setup choices from the main File
menu.
Option Print Setup permits the usual Windows driver quality and media selections to be made
Option Print Current View takes the scan data as seen in the Viewing Desktop Window
How to use the Print option
1.

If you wish to print the whole scan press the
view window

button to display the whole image in the

2.

If you require only part of the image to be printed, zoom the image until the required section
fills the view window

3.

Select Print Current View, choose the paper size in the printer and press Print

NOTES:
Printer drivers can behave according to their own set of rules, particularly large format printers
where the outputted paper size can vary between A4 and A0. You may experience odd
relationships between the size of the image to be printed and the actual output. ScanWorks
displays the image size in the status information at the top of the image window

TIP: From the Control Panel, create a Custom Test Paper size and use this to check how your driver behaves inside ScanWorks
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14 ScanWorks Batch processor
The ScanWorks Batch feature allows the scanner operator to perform a variety of editing and
reformatting functions on scan data AFTER scanning. The instructions for the Batch operation
can be taken from a pre-existing Preset or entered through the Batch dialogue. Typical Batch
operations might be to rotate documents or compress them into a smaller file formats or even
change the format altogether.

14.1 Running Unattended (Auto-save)
To compress Black and White files select Create Batch and set as follows:
1.
2.
3.
4.
5.
6.
7.

Select settings for Batch, choose Use current settings
Place the uncompressed files in a separate directory and then click Add to browse.
Marquee the files for processing and press OK
Click Run unattended (Auto Save)
Check Save images in new location and browse to a new directory to hold the compress
form of the files
Check Save images in new format select TIFG4 from the pull-down choices. File re-formatting must be done in this mode
Supply a name using the … button and press OK
Select Run Batch from the ScanWorks File menu and browse to the name entered in 6. To
run the batch press OK

14.2 Running with Operator present (Quality Control mode)
This permits the operator to process previously scanned files using the ScanWorks Editing Tools. Operations like crop, rotate and deskew
can be carried out on the scans before pressing the Save Changes Get Next Image or Discard Changes Get Next Image buttons. Change the
QC setting to Operator Present to activate.
TIP: If you experience problems with the last file in unattended
mode turn off log file generation. If use of Crop hides the
image, press the right-mouse button to restore the image
behind the crop lines.
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14.3 Using Presets with ScanWorks Batch command
Preset can be used to pre-select operations such as Rotate and Invert for example and the Preset can then be called upon by a Batch
process to operate on a group of pre-scanned files. ScanWorks Batch Preset uses only the Editing commands of the Preset and any settings
in the Preset dealing with Format change will be ignored. For example to Rotate and Invert some uncompressed Black and White scans
follow the instructions below.
1.
2.
3.
4.
5.
6.
7.
8.

Make a black and white scan with ScanWorks to establish the correct scan settings - Black and White Mono
Activate the Invert and Rotation tools within the Editing Tools and specify Inline by clicking the Arrow. Save as a Preset
Select Create Batch… from the File menu of ScanWorks
Choose Use settings from Preset (the Preset created in step 3 above)
Add files to be processed in the normal way
Choose to Run with Operator present or using Timer
Give the Batch a name and press OK
Run the Batch named in step 7

Typical Workflow
Batch Add command
controls which files are
processed.

Current editor
settings or settings
from a Preset are
applied

Reformat with
Unattended Mode

Manual Edit / Quality
Control with Operator
Mode

New format in new
folder

Edited data in same
folder

TIP: Select files for processing in groups of ten. Use the file
date stamp to confirm which files have been processed.
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14.3.1 The Batch Command interfaces.
Operator Present Mode
The settings displayed right are as follows:





The Settings will be taken from the Turn & Invert Preset
Quality Control is ON which means that Save and Delete
buttons will be displayed in the viewer for each scan
The Batch has been given a name QC Mode Turn & Invert
Note files cannot be converted in this mode only edited.

TIP: Batches cannot be stopped once started, therefore group files in
manageable numbers
TIP: When deleting files from the Batch always select the file(s) using the
mouse and/ or shift key before clicking delete. Files can be added to
existing batches from different directories.
Unattended Mode
The settings displayed below are as follows:




The Settings will be from the Turn & Invert Preset
Quality Control is OFF which means that all selected files
will be processed in one continuous operation
The Batch has been given the name Compressor
unattended
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The options not set are listed below:




Log file in text format (same folder as batch.or .bch files)
Delete original images
Schedule for timed operation

TIP: Batches cannot be stopped once started. Group files in
manageable quantities.
TIP: Keep Delete original images option unchecked and always
maintain backups of important files

14.4 Using the ScanWorks Batch Scheduler
If a Batch is created with a time set up using the Schedule fields of
the configuration screen and this batch is run from the ScanWorks
Run Batch… command (File > Run Batch) ScanWorks launches the
Batch Scheduler.

14.5 Creating a Batch configuration in ScanWorks
Use File > Create Batch… and complete the boxes inside the interface. Make selections for operator quality controlled batch processing or
stand-alone processing without an operator. In stand-alone mode all processing is handled totally automatically

14.6 Editing a Batch configuration in ScanWorks
Use File > Edit Batch… and select the batch to be edited.
TIP: Editing a batch does not allow the user to change or select a different Preset. The purpose of the Edit Batch command is to
select new files for batch processing. To have a batch use a different Preset create a new batch and choose a new name or
overwrite the old batch name.
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15 Color Classification
ScanWorks Color Classification allows the user to carry out the following operations:




To change any color in the scan to a different color
To change a group of colors to any member color or a different color completely
To reduce the number of colors in a scan for the purposes of reducing the file size or making the data suitable for vectorisation

15.1 Reducing a Full Color scan to 64 or fewer colors
1.
2.
3.
4.
5.

Begin by clicking the icon above in the More Controls tab. Note Color Classification is only
available when DataType is RGB or 24-bit Full Color.
Zoom into the image and note the coloration across the picture
Change the number in the Best fit to box from 256 to 64
Press the Classify button and note the change in the background as seen in the viewer behind
In the Color Classification window press
in the lower left hand corner

6.

Supply a palette name and press OK

Note that image has reverted to full color but the filename supplied in 6 has been entered into
the palette name field. We are now told the palette contains 64 colors. To convert the
scanned image to 64 colors either press the Apply button or press
to replace the standard
256 color palette with this 64 color palette in the Color Palette / File Format tab of the Scanner
Configuration Controls area. If the palette is replaced by the 64 color version the document
will need to be scanned again to produce a new 64 color version of the same document. This
palette can now be used with other similar documents. Scans containing between 16 and
256 colors occupy one third of the disk space of files scanned in Full Color – (uncompressed
TIFF)
TIP: To use this palette regularly the DataType must be changed to 256 Colors(Fixed) from RGB or the scanner will still scan in
Full Color. TIP: Use
to see the Full Color version and
to see the Palette reduced image
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15.2 Combining and changing colors in a scan
To further reduce the colors from the Color Classification
dialogue move the slider in the top-right corner and press the
tick below. To apply the new colors permanently to the scan
without rescanning press the tick in the lower-left corner,
supply an name for the .apt file. Now press the Apply button
in the ScanWorks Color Classification tab.
To change one color in a scan . . .
1.
2.

3.
4.

Choose the 3-D representation icon and Sort by
Lightness
Use the
to click on the scan and identify a color
to the Color Classification module. The Current
Color will change to the color under the Dropper nib.
To change the color move the sliders
To save the scan with these changes click the tick in
the lower left corner and Apply

To change more than one color in a scan . . .
1.
2.

3.

68

Choose the 3-D representation icon and Sort by
Lightness
Use the Dropper
to click on the scan and identify a
color to the Color Classification module. The Current
Color will change to the color under the Dropper nib.
Use the Color Combine Button
to place a marquee
(or square) over the colors to be combined / changed.

Printed information
often has more than
one colour making up
a colour - as in the
example of blue
(right)
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Combining and changing colors in a scan contd. . .
4.
5.
6.
7.
8.

Move the marquee around and use it to add more colors to the merge
list.
Identify the colors selected in the merge by pressing the
icon
Change the color of the Identifier color using the
icon
Alter the color of the merged colors using the sliders
Click
in the lower left to save the palette, then press Apply to apply
this to the Full Color scan

New color

Identifying merged colors
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16 Appendix
16.1 Hardware Installation – (skip this section if your scanner is already installed)
16.2 USB2 precautions
Where there are USB peripherals sharing the same computer and these are USB 1.1 standard, the USB2 speed of SmartLF will not be achieved
and scanning will be slow. If it is necessary to use USB 1.1 devices alongside SmartLF these should be used with via a separate USB channel e.g.
by fitting a secondary USB card to separate the SmartLF and any slower USB 1.1 devices.

16.3 Computer hardware recommendations
SmartLF needs a Hyper Threaded Windows XP or Windows Vista, 2.8GHz, 2GB RAM computer as a minimum specification to meet the speeds
described in the documentation.

16.4 Cable length
The standard USB2 cable supplied with all Colortrac SmartLF scanners is 2 metres long. Longer cables can be used but care should be exercised
because the quality of USB2 cables and USB2 adapter cards can vary, even for similarly priced examples. There is no restriction on the length of
Ethernet cable.

16.5 Color Depth file size calculations (without compression)
A few useful calculations covering the storage space needed for various methods of scanning.
For a Full Color or RGB file each pixel occupies 1 byte for red, 1 byte for green and 1 byte for blue or 3 bytes per pixel. This means that each pixel
can have 256 levels of R, G and B or 256x256x256 or 16.9 million colors. A 200 dpi A0 file will be 207MB.
A 24-bit full color file will occupy 3 bytes for every pixel. A 200 dpi A0 file will be 200 x 36 x 200 x 48 x 3 byte per pixel = 207 MB in size
A 256 color file occupies 1 byte for every pixel. A 200 dpi A0 file will be 200 x 36 x 200 x 48 x 1 byte per pixel = 69 MB in size
A 16 color file occupies 24 = 16 or half of 1 byte per pixel. A 200 dpi A0 file will be 200 x 36 x 200 x 48 x 0.5 bytes per pixel = 34 MB
A Black and White or binary file is 20 or = 1 or one eighth of one byte per pixel. A 200 dpi A0 will be 200x36x200x48x0.125 bytes per pixel = 4.3MB
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16.6 ScanWorks licensing limitations
ScanWorks image editing for non-TIFF images is not limited to a single user. This means that ScanWorks can be installed on second and
subsequent computers and the saving of data to file formats supported by the image libraries within ScanWorks will still be available. ScanWorks
will not operate without the appropriate dongle when a scanner is connected.

16.7 Turbo Mode button
Turbo Mode was a feature of the Series 4 Colortrac scanners and is not supported by the SmartLF.
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